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Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave

64-bit Windows 7 Pro Shutting Down Problems; Does Leaving Computer On Shorten Life?; Windows
Media Player Not Playing WAV Files.

64-bit Windows 7 Pro Shutting Down Problems
Dear Digital Dave,

I'm running the 64-bit Windows 7 Pro. I do not Hibernate/Sleep! But lately when I try to shut
down the system, it takes so long for Windows to shut itself down that it feels like eternity—
I'm afraid to report.

Would you, please, enlighten yours truly a little as to what on Earth is going on here! Am I
in the middle a joke, and do not know about it or something? I thank you infinitely.
Jay Siena
Kyoto, Japan

Dear Jay,

I suppose that telling you not to shut down your computer is not the answer you're looking for.
There are a number of things that can cause your computer to take a long time to shut down.

It's usually a particular program or service that is the culprit. The process is either not
responding or not allowing itself to be shut down. It could also be that you have too many
programs running in the background. Even if you have closed all active programs, Windows
still needs to close all of the background processes before exiting. If you take a look at the
Task Manager (CTRL+SHIFT+ESC), you will be able to see all of the processes still running.
It's probably not hardware unless everything else is also slow.

Since this problem has only started occurring lately, I would suspect that something has
changed. Did you recently add new software? If so, you might try restoring to an earlier
restore point.

Or, it could be a problem with reading from and writing to the hard drive. Sometimes it's a bad
connection and other times it could be a bad sector or two.
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I would definitely run CCleaner through its paces and a standard answer is always to look for a
virus. Shutdown problems are not dissimilar to start up problems. Windows needs to go
through its checks to make sure everything closes down properly. Flakey software or
intermittent hardware can contribute to the problem. At least in the interim, although not very
elegant solution, you could leave your computer running.

If you can't isolate anything, something that might help is adding more memory. Remember
that Windows will shuttle memory contents off to the Pagefile on the hard drive when the
RAM gets overloaded. When you close down your computer that Pagefile must be read back
into memory with the appropriate portions either written back to the hard drive or closed
down. The more the hard drive is used, the slower the process will be. Adding more memory
usually will speed up this process.

Digital Dave

Does Leaving Computer On Shorten Life?
Dear Digital Dave,

Thanks so much for all the advice you've provided me over the years.

You mentioned in your last issue that you don't let your computer sleep or hibernate, but you
do shut it down once in a while. I would like to the same with mine.

I have a six year old Dell Inspiron 530 running Windows 7, with maxed out RAM and with
all of your hints incorporated to help it run and boot as fast as possible (short of over
clocking). However, booting from scratch takes close to ten minutes and that's slow when
you want to use it now. Waking from sleep is also slow. So, I'm wondering if leaving it on is
going to shorten its life significantly. I do open it now and then to blow out the dust and shut
it down once a week.
Poz
San Diego, CA

Dear Poz,

If it takes ten minutes for a Windows 7 machine to boot up, then there is definitely something
slowing it down. Whether it is an overload of Startup software, a hard drive problem, or other
issue is hard to know. I certainly sympathize with leaving a computer on all the time for
convenience, monitoring other activity, and avoiding slow startups.

The truth is that the only downside to leaving a computer running is power consumption.
Electronic components go through an initial period called burn-in. This is the time when they
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are most likely to fail. If they don't go down early on then they are likely to continue working
for a long time. This is why the best manufacturers burn-in their systems for some initial
period of time.

After the burn-in period, the time that electronic components are most likely to fail is when
they receive that initial surge while powering up. Although today's systems are designed to
minimize any initial electrical surges, anytime you turn on your computer there is still some
effect. Leaving your computer on is actually less risky since there is no on/off cycling. In
either case, on or off, you are not likely to have much of a problem if you never experienced a
problem during burn-in (the first 100 hours or so).

After that initial period, the most likely components to fail are mechanical (hard drives). Again,
powering up and powering down the drives can add to the long run risk.

Digital Dave

Windows Media Player Not Playing WAV Files
Dear Digital Dave,

I'm able to play WAV files on my laptop using WIN 8.1. When I attempt to play the same
WAV file on another laptop that I have using WIN 7.1, I receive an error message stating
"Windows Media Player cannot play the file. The player might not support the file type."
Using the "go to Web for a solution" doesn't help.

Please offer a solution to my dilemma, thanks!
Mike
Cardiff, CA

Dear Mike,

Most likely you're missing the proper codec (coder/decoder) for WAV files. Software packs of
codecs can be found in numerous places on the Web. One of the most popular is K-Lite
Codec Pack which also includes other tweaking tools. If you download the pack from the
CNET, be sure to use the Direct Download Link (See Figure 1). This will avoid other
unwanted CNET chaff software from being offered.
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Figure 1. Use the "Direct Download Link" on CNET's Download.com to avoid extras being offered with the
installation.

Every media format has its own associated codec to play the files. If it's missing from your
computer, you won't be able to play that type of file.

Digital Dave
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Self-Publishing E-Books on Amazon
“If Plan to Sell E-Books, You Want to Use Amazon--In Spite of the Rules” by Jack

Dunning
Amazon is the number one e-tailer of e-books in the world. Because of that, they make all the rules.

If you're planning to sell e-books, then you want to sell them on Amazon Kindle Direct
Publishing (see Figure 1). It may not be the only place you sell your books, but by a wide
margin you will most likely sell more books with Amazon than any other e-tailer. The list of
weak selling outlets for most e-books includes notables such as the Apple iTunes Bookstore (at
least for Windows books) and Barnes and Noble. Amazon is the only site other than
ComputorEdge E-Books which carries all of our books (except the free books). A regular
number of books will sell on Amazon, but unless you happen to have a best seller, then you're
not likely to generate enough income to live on. While posting an e-book on Amazon is easy,
there is much more work involved in selling it.
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Figure 1. Kindle Direct Publishing makes the rules for independent authors selling books.

Quite frankly, I gave up on Apple iTunes quite a while ago. They were difficult to work with,
took weeks to activate a book, made it too difficult to change data, and required useless
information such as an ISBN (retail book code of which I have plenty from a previous book
publishing business) which serves no purpose for e-books. The few sales that trickled
through weren't worth the effort to post the books. Many of these problems may have been
fixed, but I've moved on after a reasonable test time. I now have other plans. Barnes and
Noble is much easier to use (similar to Amazon) without all the extra Apple hassle, but its
sales still pale in comparison to Amazon. I'm not in a rush to add all of my books to Barnes
and Noble.

Amazon Makes the Rules
It may not be fair, but many of the standards for selling e-books are based upon the whims of
Amazon. Who argues with an 800lb gorilla—especially when he's not likely to listen? Amazon
owns much of the e-book market and most people will sell more e-books there than anywhere
else. If you don't like the rules, then you can go it alone—which may not be much of an
option.

The first Amazon rule is to price your e-book between $2.99 and $9.99. Amazon has decided
that e-books should cost somewhere within this arbitrary price range. This is enforced by
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offering 70% royalties to any author who stays within the blessed price range while only
yielding 35% when a book does not comply. That's a huge difference and it forces authors to
stay within these limits. This is not totally a bad thing, but it doesn't seem to be based upon
any sort of rational reasoning—especially on the high end.

I can see this price fixing on the low-end ($2.99) since Amazon does have certain minimum
costs (although they're probably minuscule on a per book basis). But why limit the price of a
book on the high end? The worth of a book is based upon the value the reader receives. In
some narrow markets—especially technical books—the value could be extraordinary for those
who need the book. But if an author can only charge $9.99 without sacrificing substantial
royalties, then it may not be worth it to even start writing. Many computer books fall into this
category (although not mine). These price "guidelines" have a major influence on how authors
write books.

For example, the three AutoHotkey books I now have available on Amazon all fall within that
$2.99 to $9.99 price range. The least expensive is A Beginner's Guide to AutoHotkey at
$3.99. This is the shortest book at 128 pages (PDF with letter size pages)—Amazon estimates
163 e-book pages. The second book Digging Deeper Into AutoHotkey at $6.99 is 235 PDF
pages (339 Amazon e-book pages). The third book AutoHotkey Applications at $9.99 is 364
PDF pages and 480 Amazon pages. These books could easily be combined in to one big e-
book, but the price could not be reconciled on Amazon.

A three-book package on Amazon at the same combined price would be $20.97. Since it is
over $9.99 the royalty drops to 35% yielding $7.34. By not combining the books into one
volume, if someone buys all three books at the same total price, ComputorEdge E-Books gets
$13.26—almost twice as much. In effect, authors are forced to split up their books to fit
within these "guidelines."

This is not all bad. By having separate volumes people can wade into AutoHotkey a little at a
time without being forced to purchase the whole set. On the other hand there would certainly
be convenience in having all the information available in one searchable e-book—especially
with a combined index. This option gets ruled out by Amazon's pricing "guidelines," even if it
would be better for the user. (This is one reason that I offer the free e-book AutoHotkey
Tricks You Ought to Do with Windows. It includes the Table of Contents and Indexes from
each of the other three books.)

If you're quick with arithmetic, you may notice that some of my numbers don't quite add up.

Amazon Delivery Costs
Amazon imposes a delivery fee to the self-publisher for each e-book sold. As far as I know, no
other e-book seller does this. The royalty levels from Barnes and Noble and the Apple
iBookstore are similar (65% to 70%), but Amazon tacks on a 15¢ charge for each megabyte of
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data in the download. This charge isn't very much for books only consisting of text, but if your
books (like mine) include lots of images and screenshots, then this fee is a huge bite out of
royalties. That means I'm charged an extra 47¢ for each Beginner's Guide sold on Amazon
and 78¢ each for the other two books. Authors have no choice but to accept this charge by
Amazon—which equates to digital usury. It was impossible for ComputorEdge E-Books to
charge a reasonable price for Jim Whiting's cartoon book (virtually all graphic images) since
the delivery fee alone is $1.33. At $2.99 each—which might be reasonable for a cartoon e-
book—the royalty is 91¢—which is less than the $1.05 at the 35% royalty level which doesn't
impose a delivery fee. Amazon keeps $2.08 which is 70%. There is no way that it costs
Amazon anything near enough to download and store e-books to justify a 15¢ per megabyte.

My guess is that Amazon has looked at changing the download fee policy, but when they
calculate how many millions of dollars they would be giving up, any thought of reform is
canned. The effect is to push authors to severely limit their use of images in e-books—or
avoid Amazon completely. Even though a picture is worth 1,000 words, at Amazon, it will
cost way more than just using the words. In many ways, this policy is counter to producing
better quality books and prevents many authors away from using Amazon at all.

Amazon KDP Select Promotions
Amazon has some promotional programs called KDP Select (see Figure 2). I have participated
in these in the past, but I currently only have a couple of books (which are poor sellers)
enrolled. The main reason I don't do more with KDP Select is Amazon demands that any
book in the program be exclusive to Amazon. That means I can't make them available on
iTunes, Barnes and Noble, or even sell them on the ComputorEdge E-Books site. The
question for you to ask is whether these programs are worth it to you.
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Figure 2. The Amazon KDP Select program allows authors to offer promotions for their books, but the books must
be exclusive to Amazon.

If the only place you plan to sell e-books is on Amazon, then go ahead and enroll in the KDP
Select program. If nothing else, it places your books in the free Kindle Owners' Lending
Library program for Amazon Prime members. Each month, Amazon puts an amount of
money into a pool which is distributed among the books borrowed free by Amazon Prime
members. (This month, June 2014, the pool is $1.2 million.) When I had books in the
program, a book might average $2.00 for each borrow—which at many times was more than
the royalty for a sale. In some cases, people would borrow the book just to review it, then
later they might buy it—if they liked it. That way I could get both the borrowing fee and the
royalty for the sale. (I have no idea how many people actually borrowed a book, then later
bought it, because I have no numbers. I'm sure any borrowing, then buying would depend
upon the type of book.) KDP Select did spark sales, at least temporarily.

Another aspect of KDP Select is that you can make your book available free as a promotion to
anyone for a set number of days (five) a quarter or you can do a price promotion which can
run for up to seven days. I tested the free promotions and it did help sales after the free period
expired, however, over time it seemed to lose its effectiveness. It may have even been
counterproductive over the long haul. There are books I would like to give away on Amazon,
but I would be locked out of offering that book on other sites for 90 days—the minimum term
of enrollment for any book in KDP Select.

Another possible advantage to KDP Select program is that some regional Amazon sites (India,
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Japan, Brazil, Mexico) offer the 70% only to books enrolled in the program—otherwise 35%. I
never sold that many books in those countries, so that didn't add much of an incentive for me.

You Should Use Amazon.com to Sell E-Books
After pointing out all of my issues with its rules and programs, I do think that you should
publish your books on Amazon. There are benefits which will accrue just from being there.

First, if you have a topic of interest to many people, Amazon is the best place to generate
immediate sales. It has the widest audience of any site and is easy for people to search. If you
have a topic with a unique search term, then get it into the title (and keywords) for your book.
For example, unlike many of my other Windows books, if you type "AutoHotkey" into the
Amazon search field, my books come up at the top of the list. That means whenever a Kindle
user says, "I wonder if Amazon has anything on AutoHotkey?" I appear first. This is fortunate
in my case and won't last forever, but don't overlook the importance of the words in the book
title in this digital age. (This will come up again when discussing e-book marketing efforts.)

Kindle owners can buy your book risk free. If they don't like it, they can return in within
seven days at no cost. This means they are more likely to give it a test drive. If they like it,
they might keep it and write a good review. If not, you could get a bad review, which is often
the death knell for any book which is then relegated to oblivion. By posting your book on
Amazon, you are potentially exposing it to the largest e-book market in the world.

The fact that you have your book on Amazon gives you immediate street cred. Whether it is
warranted, or not, having a book on Amazon makes you a published author. Maybe you don't
sell any books, but at least it's there. Most people don't realize how easy it is to publish a book
on Amazon.

Another marketing benefit is the search engine ranking of Amazon. It's no secret that if you
search for your Amazon book, it will most likely appear toward the top of the list on the first
page of results. That is gold for Amazon—and possibly for your book. Just being listed on
Amazon advertises your book via the search engines. That's better than one of those little ads
in the margin—and certainly less expensive.

Amazon Alone is Not Enough
There was a time when I thought I might be able to build my marketing plan around selling e-
books on Amazon. Sales were growing enough that it appeared that by adding more titles and
using the Amazon KDP Select program I would be able to create a steady cash flow. That was
until no matter what I did, the sales started to ebb. I had set up a test site of my own for selling
e-books, ComputorEdge E-Books, but since so many of the books were exclusive to Amazon,
there wasn't much to offer. I slowly started pulling the books out of KDP Select as their
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enrollment expired and reactivated them on the site. Then a surprise occurred.

I was selling a few dollars a month at ComputorEdge E-Books, but nothing to get excited
about. In fact the cost of the site and credit cards (about $50 to $60 a month) wasn't getting
covered. Then last August for some unknown reason, the sales spiked. It more than covered
the monthly cost, but more importantly it caught my interest. One of the cardinal rules of
business is don't overlook unexpected success. The insight was that unless I had a mega hit on
Amazon, the earning potential of my own site was greater than that of Amazon—at least in
dollars cleared.

I've already explained how much Amazon takes out of every sale. But with the ComputorEdge
E-Books site, less the fixed expenses of $50 to $60 a month, the only additional cost is the
credit card percentage from each sale. That means we get to keep between 90% and 95% of
the revenue. It is quite possible for ComputorEdge E-Books to sell fewer books on its site, yet
produce a much better cash flow than it does with Amazon. Since that time, I've been
implementing a plan to do just that. We have not reached the point where ComputorEdge E-
Books generates more than the books on Amazon, but I'm now seeing continual growth. (I will
go into greater depth in future articles about how I'm marketing ComputorEdge E-Books.)

There is a way to earn another four to six percent on some of the Amazon sales. Join the
Amazon Associates Program. By adding your tag to any links you post for the books on
Amazon, you'll earn a commission on the book and anything else a person may buy. Quite
frankly, it's not likely to amount to much unless your links generate an awful lot of sales, but
it's better than nothing.

I plan to continue using Amazon, but now I see it as a supplement to my other efforts. I think
that it should be a part of anyone's overall marketing plan, but, unless selling e-books is only a
hobby, I wouldn't make Amazon the entire plan.

Next time, I'll go into more of the nuts and bolts of publishing an e-book on Amazon. I'll offer
more insights into the process and market while discussing the steps involved in becoming a
self-published author—at least on Amazon.

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in
the process of updating and compiling his hundreds of articles and columns into e-books.
Currently available:

Recently released is Jack's FREE AutoHotkey book, AutoHotkey Tricks You Ought to Do
with Window, available exclusively at ComputorEdge E-Books in the EPUB for e-readers and
tablets, MOBI for Kindle, and PDF for printing formats.

ComputorEdge E-books offering is his AutoHotkey Applications, an idea-generating
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intermediate level e-book about using the AutoHotkey Graphical User Interface (GUI)
command to write practical pop-up apps for your Windows computer. (It's not as hard as it
sounds.)

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8,
Windows 7, Windows Vista, and Windows XP Computers.

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.

Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
What They Are, What They Do, and How to Get Started!.

Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,
Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7,
Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7,
and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
by Jack about computers and the people who use them.
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Automate Any
Program in
Windows
“One Strength of
AutoHotkey Is It Can
Automate Any Windows

Program” by Jack Dunning
Although every program operates in a different manner, the flexible tools in AutoHotkey can make it
easier with any software.

During a conversation with a new AutoHotkey user it became clear to me that I had not
discussed in The Beginner's Guide one of the most important uses of the software—
automating programs. Sure, I had covered many of the commands and techniques that might
be used in setting up hotkey combinations for specific applications: Chapter Fifteen of The
Beginner's Guide, "How to Cheat at Computer Games" gives some basic techniques and
action recording apps that will help you identify the commands needed; Chapter Nine of
Digging Deeper Into AutoHotkey, "A Simple Way to Automate Any Windows Program with
(or without) Mouse Movement", gives a couple of basic approaches (the menu shortcuts and
the Click command); and the AutoHotkey Applications book includes pertinent information
within some of the Tips and Tricks. But I had never provided general guidelines for those
many times when a program forces you repeat the same steps over and over again. This is
something that should be addressed in The Beginner's Guide since it is one of the best uses for
AutoHotkey. (The information provided here will be added to the next update of The
Beginner's Guide.)

AutoHotkey Works with Any Program
While it is possible that there is a program which runs in Windows which will not work with
AutoHotkey, I don't know what it is. It would be highly unusual to find any such software.
That's the power of AutoHotkey. It works everywhere whether running from your Windows
computer or on the Web! There may be an occasional hotkey combination which will conflict
with a particular Windows program, but all you need to do is change the hotkey in the
AutoHotkey script.

There are many programs such as Microsoft Office which will allow you to record repetitive
actions and turn them into a macro you can run at any time. It is a great time saver. The
advantage to using AutoHotkey is that it will run in every Windows program you use, not just
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Microsoft Office. That means you can speed up the operation of your favorite applications
regardless of its built in capabilities. There are a few basic AutoHotkey commands needed to
start automating your program. The techniques you choose to incorporate into an automation
script depend heavily upon how the program works. Regardless, with the variety of tools in
AutoHotkey, there is almost always a way to get the job done.

New to the free AutoHotkey software for Windows computers? See the ComputorEdge
"Installing AutoHotkey and Writing Your First Script" Web page.

Automating Program Menus
The most basic way to navigate a program's main menu structure without a mouse is with the
keyboard. In many Windows programs the main menu structure is accessed with the ALT
key. Press the ALT key and the first heading in the menu becomes the focus. (If the menu is
hidden the ALT key will often expose it.) Once the menu is active, you can navigate it with the
cursor arrow keys and the ENTER key to select an option. In this case, I'm using OpenOffice
as a demonstration program. When I press the ALT key, move to the right by pressing the
right arrow key twice, ENTER to open the menu, press the down arrow key nine times to
Nonprinting Characters, then ENTER again, the hidden characters are exposed (see Figure 1).
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Figure 1. The non-printing characters are exposed by navigating the View menu.

The easiest way to simulate these steps is to navigate the menu with the Send command using
{Alt} to access the main menu, {Right} to move through the menu headers, {Enter} to open
the menu, {Down} to move to the appropriate item, then {Enter} again to select:

#y::
  SendInput, {Alt}
  SendInput, {Right 2}
  SendInput, {Enter}
  SendInput, {Down 9}
  SendInput, {Enter}
Return

This approach is simple and adaptable to virtually any menu. (In some programs other hotkeys
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may be needed to open a menu. Check the program's documentation.) This technique does
require that you first count the number to times you press each key to properly implement the
action. (I use SendInput rather than Send because it is faster and buffers the keyboard
characters making interference less likely.)

Special Note: I use the Windows key  (#) in the hotkey combination because I found that
any of the others (CTRL ^, SHIFT +, and ALT !) interfered with the SendInput, {Alt} line of
code. If you're running into a similar problem with the script not accessing the menu, then
try using only the Win  key (#) in your hotkey combination. This was not a problem once
the script was written to use the built in menu shortcuts (below). I did not encounter this
problem in the Digging Deeper book (Chapter Nine), because I was using the unless INSERT
key (Ins) as the hotkey.

Using Menu Shortcut Keys
Many programs written for Windows assign shortcut keys to each menu and its options. If the
menu does have these shortcuts available they will appear as an underlined character in the
name. Note in Figure 1 the V in View and the N in Nonprinting are underlined indicating that
they are shortcut keys. When the menu is active (press ALT), pressing V will open then View
menu, then pressing N will activate the Nonprinting Character option.

If the software you're using has these shortcuts keys, it simplifies the script and resolves the
problem with the ALT key not working when CTRL or SHIFT is used in the combination—at
least in this case. The menu can be opened by sending the ALT key in combination (acting like
a hotkey) with the V from the View menu eliminating some lines of code (see Figure 2):

^+y::
  SendInput, !v
  SendInput, {down 9}
  SendInput, {enter}
Return

Notice that I changed the hotkey combination to CTRL+SHIFT+y (^+y) since it will no longer
interfere with the SendInput, !v line.
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Figure 2. By using the shortcuts keys (circled) in the menu structure, the AutoHotkey script is simplified.

The !v now acts as a hotkey combination opening the View menu. I've left the last two lines in
place, but they can be replaced with one line which uses the N shortcut:

^+y::
  SendInput, !vn
Return

This particular script toggles the hidden characters on and off, so each time the hotkey
combination is used the process is reversed.

Tip: It is best to use lowercase letters in hotkeys and with the Send command. In many
situations uppercase letters will be interpreted as SHIFT plus the letter. This can change the
meaning of the code (i.e. ^a => CTRL+a whereas ^A => CTRL+SHIFT+a). Using lowercase
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letters will save possible confusion.

Cascading Menus
While menus within menus seem more complicated, they only add minor changes to the script.
In the example in Figure 3 the View menu is used to turn the 3D Settings toolbar on and off.

Figure 3. To turn the 3D Setting toolbar on and off requires accessing the secondary menu.

The original no-shortcut keys script can be modified as follows:

#y::
  SendInput, {Alt}
  SendInput, {Right 2}
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  SendInput, {Enter}
  SendInput, {Down 2}
  SendInput, {right 1}
  SendInput, {Enter}
Return

If the desired option is further down the menu, then another line with the {Down} parameter
would be required before the last {Enter} line. But, if the shortcut keys are available, then this
is the easiest way to do it:

^+y::
  SendInput, !vt3
Return

This works because OpenOffice responds really quickly to the input from AutoHotkey. That is
not always the case with all programs and pop-up menus. Sometimes there is a noticeable
pause before the next menu or window appears—especially if it's a Web based program.
When a slowdown occurs it's possible for the AutoHotkey script to outrun the application's
response. Sometimes we need to slow the script down between each step by adding the Sleep
command. Sleep 200 will pause a script for 200 milliseconds. By placing this line (the time
duration may need to vary) between the lines of code, the script is paused allowing the
program or Web page to catch up:

^+y::
  SendInput, !v
  Sleep 200
  SendInput, t
  Sleep 200
  SendInput, 3
Return

There are also times you may want to place the Sleep command (1000 or 2000 milliseconds
for one or two seconds respectively) in a script just so you can see what it's doing—especially
if you're having problems. You can always reduce the interval or remove the code later.

Another way to pause a script until you're ready to move on (perhaps you need to use the
mouse to select some text for further processing) is to use the KeyWait command. Add the
following line at the appropriate place:

  KeyWait, Insert, D

This code puts to use the usually useless INSERT key. The D option forces the script to wait
until the INSERT key is pressed down.

Navigating Pop-up Windows
Often there is more to navigation and setting than menus. Maybe a window opens in which
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settings are selected or changed. Since the behavior differs for windows there are other
parameters that we must use with the Send command. Suppose we want to change the layout
of our OpenOffice document from Portrait to Landscape. First, the Format menu is selected,
then Page… (see Figure 4).
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Figure 4. Changing from Portrait to Landscape in OpenOffice requires another window to open.

The desired settings are located three fields down which can be reached by using TAB key.
Then the Landscape radio button must be selected and OK clicked. In this situation the
shortcuts keys are pretty much useless. Since the default control is a menu, sending a shortcut
key with AutoHotkey will only jump around in that first Format menu. Here is the alternate
approach:

^+y::
  SendInput, !o
  SendInput, p
  SendInput, a
  SendInput, {tab 3}
  SendInput, {down 1}
  SendInput, {return}
Return

The TAB key is standard for moving from field to field in both Windows programs and on the
Web. The ENTER or RETURN key is often require for execution, although it is likely to
activate whatever is the default control—in this case the OK button. The UP ARROW {up}
and DOWN ARROW {down} is for navigating within certain types of menus, list, and buttons.

Click to Success!
Another alternative is to use the Click command which simulates the click of the mouse at a
specified location (see Figure 5). You can use Window Spy (right-click on the green icon in the
System Tray of a running AHK file and select Window Spy) to get the exact coordinates
within a window.
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Figure 5. If there are no other shortcuts and the basic movement keys don't work, then the Click command is a good
alternative. The coordinates were taken from Window Spy by hovering the mouse cursor over the target.

As it turns out in our OpenOffice example, if the Page Style window shown is opened
manually and the selected tab has been changed, the script will not automatically open the
correct window tab (Page). I found no way to switch heading tabs within the window without
using the mouse. (I'm not saying there isn't a key combination to navigate the top tabs without
a mouse, I just couldn't find one.) This is a good example of when it's necessary to resort to
the Click command:

^+y::
  SendInput, !o
  SendInput, p
  Sleep 200
  Click 85,40        ; selects the Page tab
  Sleep 300
  Click 119,201
  Sleep 300
  Click 288,422
Return

As a precaution, it's a good idea to add the Click 85,40 line to any script which needs the Page
tab open. However, the Click commands takes a little longer to register with the program so it
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was necessary to add the Sleep command at critical points to slowdown the execution of the
script—first to wait for the window to open, then to allow each spot in the window to be
clicked.

Since changing the orientation of the page is not a toggle, a separate hotkey must be set up for
changing it back to Portrait mode:

^+u::
  SendInput, !o
  SendInput, p
  Sleep 200
  Click 85,40        ; selects the Page tab
  SendInput, {tab 3}
  SendInput, {up 1}   ; selects the Portrait mode
  SendInput, {return}
Return

You may also want to limit these hotkeys with the #IfWinActive command, operating only
when an appropriate window is active. This will prevent odd behavior if you accidentally hit
the key combinations while using another program.

Some programs don't use a standard menu bar. In that case, locate the proper program
hotkeys in the documentation to open menus. Lacking any such hotkeys, you may need to
settle for just the Click command.

Finding AutoHotkey Key Names
To get a quick boost when writing an AutoHotkey script to automate any program, there are a
number of action recording apps available (also written in AutoHotkey). These tools record
your actions (keystrokes, mouse clicks, etc.) while working with the target program and write
the necessary AutoHotkey code for repeating the same steps. (These scripts are discussed in
slightly more detail in "Restart Learning AutoHotkey with Action Recorders" and Chapter
Fifteen of The Beginner's Guide.) If you're having trouble knowing which key name to use
with the Send command, then these tools might help. The simplest one is probably Macro
Recorder. While Macro Creator has many more features, learning to use it will take a little
longer. In the long run Macro Creator is probably a better bet if you want something that will
actually generate the necessary script. As for me, I might start with a generated script, but then
tweak it manually.

*                    *                    *

Free AutoHotkey E-Book

Just released! AutoHotkey Tricks You Ought To Do With Windows! This e-book includes both
those tips and the reference material (Table of Contents and indexes) from the other three
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AutoHotkey books. Pick up a copy free and share it with your friends. (If you don't want to
be identified when signing up for the free book, just use a fake name and address. But the e-
mail address must be real so we can send you a download e-mail. I promise that no one will
ever get your e-mail address—at least not from me.)

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in
the process of updating and compiling his hundreds of articles and columns into e-books.
Currently available:

Recently released is Jack's FREE AutoHotkey book, AutoHotkey Tricks You Ought to Do
with Window, available exclusively at ComputorEdge E-Books in the EPUB for e-readers and
tablets, MOBI for Kindle, and PDF for printing formats.

ComputorEdge E-books offering is his AutoHotkey Applications, an idea-generating
intermediate level e-book about using the AutoHotkey Graphical User Interface (GUI)
command to write practical pop-up apps for your Windows computer. (It's not as hard as it
sounds.)

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8,
Windows 7, Windows Vista, and Windows XP Computers.

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.

Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
What They Are, What They Do, and How to Get Started!.

Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,
Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7,
Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7,
and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
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by Jack about computers and the people who use them.
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Wally Wang's Apple Farm
“The World of Wearable Computing” by Wally Wang

The World of Wearable Computing; HealthKit and HomeKit; Swift, Xojo, and LiveCode; Getting Women
to Code; T-Mobile vs. Sprint; It's a Software Problem; The Storage Tab.

With all the rumors swirling around Apple's wearable computer supposedly coming out this
fall, it's time to look at the obvious and not so obvious benefits. First of all, The Wall Street
Journal claims that the iWatch "will incorporate more than 10 sensors including ones to track
health and fitness…Apple aims to address an overarching criticism of existing smartwatches
that they don't provide functions significantly different from that of a smartphone…"

The obvious feature of the rumored iWatch is that it does not duplicate the function of a
smartphone, unlike Samsung's Galaxy Gear watch that basically crams the features of a
smartphone into a smartwatch. A wearable computer needs to give people new features that
they can't get from existing technology, not duplicate features they already have. Why
Samsung thought that shoving a smartphone into a smartwatch form would suddenly become a
hit demonstrates faulty thinking from people who lack imagination.

While everyone focuses on the potential iWatch's health and fitness tracking features, they're
overlooking an enormous range of new capabilities. In the movie industry, studios often show
rough cuts of films to test audiences to gauge their reactions. Based on the test audience's
answers to surveys they fill out afterwards, the studio might change or alter the film.

For example, Terminator 2 actually had a different ending where Sarah Connor is an old lady
watching John Connor and his son playing on a playground on the date SkyNet was supposed
to start a nuclear war. Test audiences thought this ending seemed too simplistic and cheery
that didn't fit the dark mood of the rest of the film. Based on this feedback, James Cameron
cut this ending and reshot a new ending where you see a road at night leading into the darkness
with Sarah Connor's voice telling us that if a machine can learn the value of a human life, then
maybe there's hope that people can learn that lesson too.

The problem with relying on test audiences is that they can only tell you their reactions after
the movie is over. What wearable computers can do is measure a test audience's emotional
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reactions in real-time while the movie actually plays.

By measuring a test audience's pulse and sweat, studios can pinpoint exactly where in the
movie the audience seems most emotionally engaged and where the audience might seem
bored. Now film directors can alter the film to maximize audience emotional appeal.

Just that simple example of wearable computers demonstrates new features that you can't get
from a smartphone, tablet, or PC. While critics with no imagination still cling to the necessity
for an RS-232 serial port, a physical keyboard, and Adobe Flash support, the rest of the world
can explore new ways to exploit wearable computers that were difficult or impossible to
achieve with current technology.

The future belongs to those who have the imagination to see possibilities. The past belongs to
those who lack imagination and only see how new technology fails to duplicate existing
technology. Guess who will thrive in the world of tomorrow?

HealthKit and HomeKit
With innovations right in front of everyone's face, it's still surprising that some people still can't
see where the future is heading after Apple revealed details of their HealthKit and HomeKit
software development kits for iOS developers.

Both HealthKit and HomeKit allow third-parties to develop software and hardware to take
advantage of these dual platforms. While creating a smart home with HomeKit might seem like
a trivial application, a smart home that could monitor an elderly patient in real-time could be
far more useful.

Imagine slapping wearable computers on the elderly in a nursing home. Now using HealthKit,
the wearable computer could monitor that patient's health in real-time to alert doctors of any
emergencies. Using HomeKit, the wearable computer could track a patient's movement
through a building, turning on lights automatically in their room and changing the room
temperature to best accommodate the people inside.

Elderly people suffering from Alzheimer's often wander away from home. HealthKit could
monitor changes in a person's body that often signals when that person might wander away.
HomeKit could lock the doors to keep that person from getting out while also alerting relatives
or neighbors to check in on that person.

Put wearable computers on children and now you can receive an alert if they stray too far
from you. Slap a wearable computer on yourself and your house can unlock and open doors
as you approach with an armful of groceries. If HomeKit detects someone in your house when
you're not around, it could alert you, turn on a camera in your house, and let you view the
intruder so you can verify if it's a thief or someone you know.
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HealthKit and HomeKit make little sense without a wearable computer since not everyone
wants to carry an iPhone around with them all the time. If you leave your iPhone behind, then
you can't take advantage of features in HealthKit or HomeKit, so a wearable computer
eliminates this problem by clinging to your body at all times. Combine Apple's TouchID
fingerprint sensor and you can verify your identity in ways that thieves can't easily duplicate.

Wearable computers represent a huge new world of computing in much the same way that
PCs freed the power of computers from isolated, air-conditioned rooms to homes and
businesses. Remember when mainframe and minicomputer users derided PCs as toys
incapable of doing serious work?

People who fail to see the potential of wearable computers can join the mainframe and
minicomputer users and claim that older technology will always be much better. After all if you
attach wheels and a long extension cord to a mainframe computer, it can do everything a
wearable computer can do at a thousand times the price and inconvenience, so that proves that
wearable computers have no future and everyone should be using mainframes instead.

Swift, Xojo, and LiveCode
With HealthKit, HomeKit, and the growing popularity of iOS dominating the smartphone and
tablet market (and soon possibly the wearable computer market), it only makes sense for
developers to focus on creating apps for iOS. However, how exactly should you create iOS
apps?

The free solution is to use Apple's Xcode with their Swift programming language. Right now
you have to join Apple's developer's program for $99 to get access to the beta version of
Xcode 6 that lets you write Swift programs. Swift is like a simpler version of Objective-C so
it's much easier for beginners and experienced programmers to learn.

The huge advantage of Swift is that it's free and gives you access to all features of iOS. The
disadvantage is that Swift may still be too difficult for novices to master. For novices who still
want to create iOS apps, they can consider Xojo and LiveCode.

Xojo for iOS should be available later this year, but won't allow access to all iOS features.
However, Xojo should be much easier to learn than Swift. If you know how to use Visual
Basic, you should have no problems learning Xojo since Xojo is often referred to as Visual
Basic for the Mac.

While Xojo relies on the BASIC programming language, LiveCode relies on Apple's old
HyperTalk programming language. LiveCode mimics HyperCard and can even convert old
HyperCard stacks into executable files for Windows, Linux, and OS X. Unlike both Xcode 6
and Xojo that aren't available yet for creating iOS apps, LiveCode can also create both iOS
and Android apps today.
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So if you want to create iOS apps for free, wait until this fall when Apple release Xcode 6 and
then use Swift to write your apps. If you're a Visual Basic programmer, then Xojo for iOS will
require almost no learning curve at all so you can transfer your Visual Basic skills to creating
iOS apps.

If you know nothing about programming at all and want the simplest solution, then consider
LiveCode. LiveCode also makes sense since you can create Android and iOS apps from a
single program, which is impossible to do with either Xcode or Xojo.

With HealthKit and HomeKit, iOS represents the most lucrative market for software
developers. Learn Swift because it gives you complete access to every feature in iOS. Then
consider learning Xojo or LiveCode to create iOS apps faster. If you also want to create
Android apps, LiveCode is your only choice.

Get ready to make money developing apps for iOS, especially when Apple's iWatch arrives
this fall. The iOS developer market is about to become richer for everyone, except for those
who refuse to recognize the lucrative market for iOS developers.

Getting Women to Code
Despite the money that developers can rake in, few women want to become programmers.
This has nothing to do with female abilities and more to do with the lack of role models and
perception surrounding computer programmers. Women are just as capable in programming as
men, and if more women wrote programs, maybe the female perspective could help improve
the quality of software engineering.

To encourage more women to code, Google has set up a site called Made with Code. This site
can help encourage women to write programs by highlighting how other woman have used
computer programs to perform a variety of tasks from choreographing Broadway dance shows
to mixing Jay-Z's songs.
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Figure 1. Google's Made with Code site encourages women to write programs.

Besides providing positive female role models, the Made with Code site also helps females find
programming classes and workshops in their area and connect with other women programmers
through social networks like Google+ and Twitter. The more women who learn to write code,
the better off everyone will be.

There's absolutely no reason why computer programming needs to be a male-dominated
industry. Women can write code just as well as men. They just need to get started and prove
it.

T-Mobile vs. Sprint
Given the dominance of Verizon and AT&T in the American market, how can T-Mobile and
Sprint compete? Sprint tries to compete by offering the exact same features as Verizon and
AT&T, except with smaller network coverage. That's basically a recipe for failure.

On the other hand, T-Mobile has announced a new trial plan. Get an iPhone 5S to use
absolutely free for a week. This lets you test T-Mobile's coverage everywhere you normally
go. If after a week you're not convinced, return the iPhone 5S. In many cases, T-Mobile is
betting that people will be happy using the iPhone 5S and will want to keep it while switching
over to T-Mobile.
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In the past year, T-Mobile has lowered their prices, offered unlimited data plans and texting,
and now provides a free week's worth of an iPhone 5S to test out their network. Guess which
network will likely attract more customers, T-Mobile or Sprint?

It's a Software Problem
When Microsoft released their Surface tablets, I rushed out to buy one. What stopped me was
Windows 8. With both the first and second generation of the Microsoft Surface tablets, you
can touch the screen to display the virtual keyboard in case you don't have the optional
physical keyboard attached.

When using Word, the screen slides up to display the virtual keyboard while letting you see the
text you want to edit. With PowerPoint, the screen slides up to display the virtual keyboard
while letting you see the slide you want to edit. With Excel, the virtual keyboard covers up the
cell you're trying to edit, making it impossible to use the virtual keyboard at all.

This problem appeared in both the first and second generation of the Surface tablets.
Hopefully Microsoft finally fixed this problem with their latest generation of Surface tablets,
but given Microsoft's penchant for complexity and lack of concern for the user's experience,
I'm not expecting this to change.

I'm not the only one who loves Microsoft's hardware but hates their software. Jeremy Kaplan
tried using a Surface Pro 3 tablet and found the hardware gorgeous but the software sorely
lacking. When he tried to adjust the trackpad settings in Windows 8, he discovered that
Windows 8 has two Control Panels for modifying settings.

Even worse, each Control Panel changes different settings. That means if you don't use the
right Control Panel, you might not know of additional settings you can modify.

Here's the big question for everyone who loves Windows. Why have two Control Panels
instead of just one? If you're going to have two Control Panels, why don't both Control Panels
let you change the exact same settings?

By putting different settings in two different Control Panels, Windows 8 simply complicates
matters for absolutely no good reason. Why did Microsoft duplicate the exact same feature
and confuse users by letting each Control Panel change different settings that the other one
cannot?

Microsoft's love of complexity isn't just limited to Windows 8. In Word 2010 you can open a
document in two steps. Click the File tab and then click Open to display an Open dialog box.
To do this exact same task in Word 2013 now takes four steps.

In Word 2013, you have to click the File tab, click Open, click the Computer icon, and then
click the Browse icon before you can see the Open dialog box. Why did Microsoft think that
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doubling the number of steps to perform the exact same task was somehow an improvement?

For a software company, Microsoft seems to love adding steps, hiding commands, and
duplicating features without making their software simpler, easier, or faster to use. By
increasing complexity while confusing the user, Microsoft seems intent on making computers
as difficult to use as possible. Given a choice between a computer that forces you to learn how
to use it vs. a computer that lets you use it with little training or studying at all, which type of
computer do you want to use?

*                    *                    *

If you're curious to know what types of files are taking up the most space on your hard disk,
click the Apple menu and choose About This Mac. Click the More Info button and then click
the Storage tab. Now you can see a color coded displays of what types of files take up the
space on your hard disk.

Figure 2. The Storage tab lets you see the files taking up the most space.
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In the early days, before Wally became an Internationally renowned comedian, computer
book writer, and generally cool guy, Wally Wang used to hang around The Byte Buyer
dangling participles with Jack Dunning and go to the gym to pump iron with Dan Gookin.

Wally is responsible for the following books:

Microsoft Office 2013 For Dummies

Beginning Programming for Dummies

Beginning Programming All-in-One Reference for Dummies

Breaking Into Acting for Dummies with Larry Garrison

Strategic Entrepreneurism with Jon and Gerald Fisher

How to Live with a Cat (When You Really Don't Want To)

The Secrets of the Wall Street Stock Traders

Mac Programming For Absolute Beginners

Republican Fairy Tales (Children's Stories the 1% Tell About the Rest of Us)

The Zen of Effortless Selling with Moe Abdou

The 15-Minute Movie Method

Erotophobia (A novel)

Math for the Zombie Apocalypse

How to Write a Great Script with Final Draft 9

How to Write a Great Script with Fade In

The Elements of a Great Script: Star Wars

The Elements of a Great Script: Die Hard

The Element of a Great Script: Back to the Future

The Elements of a Great Script: Rocky

The Elements of a Great Script: It's a Wonderful Life
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In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15
Minute Movie Method," finding interesting news stories about cats at his site "Cat Daily
News," giving advice to authors who want to self-publish e-books at his site "The Electronic
Author," and providing the type of advice he wishes someone would have told him when he
was much younger at his personal Web site. Wally can be reached at
wally@computoredge.com or you can follow him on Twitter @wallacewang_com.
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Editor's Letters: Tips and
Thoughts from Readers
“Computer and Internet tips, plus comments on the

articles and columns.” by ComputorEdge Staff
"Home Automation," "How about a Scanner," "VoIP," "Laptop Booting Windows 7 Home Premium"

Home Automation
[Regarding Jack Dunning's June 6 article, "Internet Connected Devices":]

I currently have a home automation system that utilizes the Wi-Fi in my home. I would like to
see a new style though. Currently I have a hub connected to my Wi-Fi and then it speaks to
the other devices which are various electrical outlets, cameras, door switches and a thermostat.
However since my whole house is in range of my Wi-Fi I would have preferred just to have
each device communicate directly using Wi-Fi rather than through a hub as it is my belief that
this would be a faster connection. I don't like to wait to be able to turn off the lights.

-Paul Anthony, San Diego, CA

How about a Scanner
Will someone please create a Wi-Fi scanner? Preferably with a touchscreen. Connectivity with
your smartphone would be even better as it would keep cost down.

I want to be able to scan one and two sided various sized documents, and then select where it
goes on my Dropbox or Cloud storage folder. It should be small and portable so I can take it to
any room in my home or office, and low cost, around $79.

Also I want it to be uncomplicated, just choose color only if you need it and OCR only if you
need it. Default should be as fast and easy as a high end copier with multiple page documents
stored as a PDF.

[Regarding Jack Dunning's June 6 article, "Internet Connected Devices":]

If it is a business card then it should scan both sides and convert it to fill your contacts list and
let you choose a business, personal or whatever location you wish. I want to get rid of all the
paper, and the need to file it in a cabinet, or business card holder. If it is a bank statement I
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want to quickly just drop the paper in and select a "macro" that lets it know it is to be filled
with all my other bank statements from this account. If this is something that is to be filed into
its own category them I want to use the touchscreen to select where and create a new folder of
needed.

If this is some coupon then I want to scan, and crop it if necessary, then be able to pull it up
on my smartphone later. If it is a document needing to be signed and delivered then I want to
be able to scan it, and then using the touchscreen sign and date it, then email it off. In short, I
want a paperless office for the masses.

-Paul Anthony, San Diego

VoIP
[Regarding Jack Dunning's June 6 article, "Internet Connected Devices":]

If you have Merlin@home transmitter (pacemaker monitor) will not work on VoIP only on
land lines! At my old home it worked fine (I had CA LifeLine service @ $3.88 per month).
Now at my new home I can't get CA LifeLine and AT&T U Verse is $25.00 per month! If
you have AT&T U Verse you can't have CA LifeLine service!

-Walter SW, San Diego, CA

Laptop Booting Windows 7 Home Premium
[Regarding the June 6 Digital Dave column:]

Encountered this exact issue today(!) when helping a friend load WIN 7 into a C700 Compaq
notebook. Check PC health report in WIN 7 to see that there are not issues detected with the
HDD.

Download the free SeaTools ISO and generate from it a bootable CD that will evaluate the
HDD. If SeaTools encounters any error(s), then depending on the type/kind, SeaTools may
provide an option to fix them (eg, reallocate one or more bad sectors).

You may then have to use your OS installation CD and use it to repair or even possibly re-
install WIN 7. If it is a re-install, then before installing, "WIPE" the drive (clears artifacts),
then create the new OS partition (create & format) using the OS installation CD. Monitor the
HDD performance in PC Health to ensure that it remains stable (ie, no more errors happen).

If any additional/subsequent errors occur over time, then replace the HDD as drive failure is
likely.
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-Chris Romel, San Diego, CA

I have experienced the same thing on an older laptop with minimum ram. I found out that it
was indexing every drive and storage device hooked to the computer plus the virus program
was trying to scan the same devices on startup.

One other thing that I have found on occasion is there is an error message from Win 7 or some
program that is trying to load. This error message is waiting for a keypress and other programs
in the load up queue can't proceed until you press Y, N or OK. To add to the problem is the
fact that some Win 7 error messages stay hidden behind other program screens or in the info
section on the right side of the taskbar. There is a small up arrow there that if you hover your
mouse over it will say "show hidden icons". Click on that arrow and it will show all icons
generated by Win or other programs, check to see if any of them is an error message or a
warning that something needs to be done to continue startup. You may also have to change the
order in which programs start. Google "startup manager".

-Buck, El Cajon, CA

ComputorEdge always wants to hear from you, our readers. If you have specific comments
about one of our articles, please click the "Tell us what you think about this article!" link at
the top or bottom of the specific article/column at ComputorEdge.com. Your comments will
be attached to the column and may appear at a later time in the "Editor's Letters" section.If
you want to submit a short "ComputorQuick Review", or yell at us, please e-mail us at
ceeditor@computoredge.com. If you would like to review our recent e-books, please visit
ComputorEdge E-Books.

Send e-mail to ceeditor@computoredge.com with questions about editorial content.
Send mail to cewebmaster@computoredge.com with questions or comments about this Web site.

Copyright © 1997-2014 The Byte Buyer, Inc.

ComputorEdge Magazine, P.O. Box 83086, San Diego, CA 92138. (858) 484-1998

Click to Visit ComputorEdge™ Online on the Web!
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